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About This Book

Purpose

This Guided Tour introduces you to Novell® exteNd™ and shows you how to develop a Web Service and
build it into a Web application.

Audience

This Guided Tour is for application developers familiar with building applications that provide a
graphical user interface.

Prerequisites

Experience This Guided Tour assumes you are familiar with visual development tools and
comfortable with building forms that bind to data sources such as relational databases.

Required software If you installed the Novell exteNd Professional Suite 5.2.1 or Enterprise Suite
5.2.1, everything you need is on your computer.

This includes:

+ Novell exteNd Application Server 5.2.1
+ Novell exteNd Composer " 5.2.1

+ Novell exteNd Director” 5.2.1

Plus:

+ MySQL as the database

+ exteNd LDAP as the LDAP directory

+ The exteNd Director template project, which includes an exteNd Composer project (these projects
are included in the GuidedTour.zip file in Docs/GuidedTour in your exteNd installation directory)

If you don’t have the required software, you can download the trial version of Novell exteNd 5 from the
download Web site.


http://download.novell.com/

Organization

Here’s a summary of the lessons you’ll find in the Guided Tour:

Lesson

Description

1 Getting Started

Provides an overview of the Guided Tour
application and shows you how to set up the
Guided Tour project and database

2 Completing the exteNd
Composer Project

Shows you how to complete an exteNd
Composer application that extracts information
from an LDAP directory

3 Deploying and Testing the
Web Service

Shows you how to deploy and test the exteNd
Composer Web Service component you have
created

4 Completing the exteNd
Director Project

Shows you how to complete an exteNd Director
portlet application that invokes the deployed
Web Service

Latest updates

For the latest updates to this Guided Tour and the source files used, go to the documentation Web site.

Novell exteNd 5 Guided Tour
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Getting Started

About Novell exteNd 5

Novell exteNd 5 is a comprehensive suite of development tools that gives you the ability to create end-
to-end Web Services that are secure with little to no coding.

+  With exteNd Composer you can produce Web Services that use non-XML data sources such as
directories and relational databases.

+  With exteNd Director you can write applications that allow end users to consume Web Services.
You do this by building portlets that can then be deployed as part of portal Web applications.

+ By also using exteNd Director to create forms that are bound to the data in Web Services you can
craft truly complete business solutions with minimal coding.

+ Finally, by deploying your application to the exteNd Application Server you are deploying to a
standards-based server that provides a robust environment to support your applications.

Novell exteNd 5 provides a service-oriented architecture (SOA) that is standards based. exteNd 5 gives
you all the tools you need to develop Web Services and Web applications to meet the ever-changing needs
of your business—while using current and evolving standards that do not lock you into a specific
platform.

For more information

For See

More information about Novell exteNd  The Web sites listed in the exteNd Help
Library menu at the top of this page

More information about the The Learning Resources page in
technologies discussed in this Guided =~ Welcome to Novell exteNd in this help
Tour system

Latest updates to this Guided Tour Check the exteNd documentation Web
site frequently for updates to this Guided
Tour

About the Guided Tour

Overview of the application

The application (it is more like a part of a larger application) you will build in this Guided Tour will
retrieve basic contact information from an LDAP directory (such as Novell eDirectory’"). You will
retrieve basic information such as full name, title, phone, and e-mail address. Then the information will
be displayed in a portlet that is part of a Web application. While this is a simple read application, it is the
start of a more complete solution—where users can maintain contact information about themselves or
other directory users.

Getting Started 9
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Objective

The Web Service you will create could also be used by other portlets to tailor their functionality to give a
customer or other user of your application a personalized look. In developing the Web applications of
tomorrow, developers need to provide users the information they need. The simple example you will
build leads you in that direction by showing how to retrieve information specific to a user based on a
centralized directory repository.

This Guided Tour is not intended to be a complete coding exercise—but rather an introduction to exteNd
and how you can use it to create Web Services and use them in a Web application. Your starting point will
be a partially completed project. You will write some code to complete the application, deploy the
application to the exteNd Application Server, and test the code you have completed by running the
application in your favorite Web browser.

The code provided for you is well commented, and it would be instructive to review it as you work
through the Guided Tour. You will become familiar with some of the key artifacts. You will also learn
how exteNd Composer and exteNd Director help you build applications that solve business problems
while minimizing the code you need to write.

How you will proceed

You will begin by performing the setup of the template project and database required by the application.

Then you will complete an exteNd Composer service that will extract the user information from the
LDAP directory, ultimately deploying this as a Web Service.

After completing the exteNd Composer part you will go into exteNd Director to complete the user
interface. The Web application will request a User ID and invoke the Web Service, returning either the
information about the user or an error message. The returned information will then be displayed.

Now you are ready to start the first lesson.

About this lesson

Objective

In this lesson you will extract the template project to create your project work area and create a database
required for the exteNd Director application. You will set up a connection pool in the exteNd Application
Server for the exteNd Director database. You will also start the exteNd Application Server and the exteNd
LDAP server that you will use for deployment and testing.

What you will do

1 Create a project area folder

Create the MySQL database

Start the exteNd Application Server
Create a JDBC connection pool

Start the exteNd LDAP directory server

a b ON
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EXERCISE 1-1: Create a project area folder

The template project is located in the \Docs\GuidedTour directory under your exteNd 5 installation
root directory. (The default installation root directory is C: \Program Files\Novell\exteNd5. This is
the path name that will be used in the examples in this Guided Tour.) The project is in a zip file called
GuidedTour.zip.

+ Extract the file template.zip from GuidedTour.zip, and unzip template.zip into a working directory
on your computer, such as D:\GuidedTour. When extracting the file, make sure you use an option
such as Use Folder Names, which will keep the folder structure of the files in the template.zip
during the extract. This will be your working copy of the Guided Tour project.

The folder template with the folder RequestUserInfoProject is created in your working directory.
RequestUserInfoProject is the exteNd Director project folder.

TIP: All references to these projects throughout the Guided Tour use the base location of
D:\GuidedTour\template.

EXERCISE 1-2: Create the MySQL database

An exteNd Director application requires a database to store the data specific to exteNd Director. For the
application you are building you will need to create a database and set up a connection pool in the exteNd
Application Server. Now you will create a MySQL database.

TIP: TIP: You can actually use any database supported by exteNd Director. For information on the
supported databases, see the Release Notes for exteNd 5.

For this exercise you will be executing a SQL script that will create the database and assign a user as the
owner for the database. You will use a command line utility provided with the install. Alternatively, if you
have a tool such as the MySQL Control Center you may use it to execute the script.

The script is called databaseCreationScript.sql and is located in the template folder that you extracted
in EXERCISE 1-1: “Create a project area folder”.

1 Open a Command Prompt, then use CD to change to the MySQL\bin directory in the exteNd
installation directory (for example, C:\Program Files\Novell\exteNd5\MySQL\bin).

2 Type “mysql.exe”, then press Enter.

3 At the mysql.exe prompt type \. D:\GuidedTour\template\databaseCreationScript.sql, then
press Enter.

ommand Prompt - mysql.exe

sZwGuidedTour\templateZdatabaseCreationscript.sql
rows affected (0.02 sec)

row affected {(D.00 sec)
rows affected (0.13 sec)

ZGuidedTour\templateZdatabaseCreationscript.sql
rows affected, 1 warning (0.00 sec)

row affected {(D.00 sec)
rows affected (0.08 sec)

D -\ programsynovel 1hextend5214MySQL \bin>mysql. exe
Welcome to the MySOL monitor. Commands end with ; or \g.
Your MySQL connection id is 90 to serwver wversion: 4.1.9-nt-max

Type 'help;' or "\h" for help. Type '“c' to clear the buffer.
mysql> %. D:\GuidedTour\template\databaseCreationScript.sql

NOTE: The location of the script depends on where you unzipped the template files in EXERCISE
1-1: “Create a project area folder”.

4 Type \q, then press Enter to exit the mysql.exe program.
5 You have completed this exercise.

Getting Started 11


http://www.novell.com/documentation/extend52/Docs/help/Director/relnotes.html

EXERCISE 1-3: Start the exteNd Application Server

+ To start the Application Server, go to the Start>Programs>Novell exteNd 5.2>AppServer menu
and select Application Server. (Do not select the debug option.)

B Bn appserver 4 ication Serve
% ‘Windows Update —
S .@ Composer Application Server

E Programs L4 @ Arcessories L4 @ Director Cache Manager

@ Documents L4 @ Startup L4 @ MySQL L4 Dispatcher

_% Settings L4 @ Internet Explorer @ Messaging Platform L4 @ Load Manager

@ Search L4 @ WinZip L4 @ Web Services SDK L4 Server Management Console

The application server has completed its startup initialization when you see the following text on
the server console (the build number and server/port might be different in your install):

exteNd application server [Build Number:Release5.2.0 (040524 1)] serving at:
http://jgdext5testvm:80 (runtime, admin)

EXERCISE 1-4: Create a JDBC connection pool

The database you created will be accessed as a connection pool in the Application Server. This improves
the performance of the application and provides flexibility in deployment by leaving the specification of
which database to use until deployment time. Now you will define a pool in the exteNd Application
Server.

1  When the Application Server is ready, start the Server Management Console (SMC) by going to the
Start>Programs>Novell exteNd 5.2>AppServer menu and selecting Server Management

Console.
= L4 Application Server (debug)
% ‘Windows Update | o
,@ Composer L4 Application Server
=z Programs L4 @ Accessoties L4 @ Director 4 Cache Manager
@ Documents L4 @ Startup L4 @ MySQL L4 Dispatcher
_% Settings L4 @ Internet Explorer @ Messaging Platform L4 @ Load Manager
@ Search 4 @ WinZip 4 @ Weh Services SDK E Server Management Cansole §f

2 Select the Pools tab in the Configuration section of the SMC.

| !, Novell exteNd Application Server Management Console - USER: Anonymous - |EI|1|

. File Wiew  Help

:@@@ g 7 9 o EX Novell

[ —

i ﬁ localhost:80 Advanced IPDDlS! Datab C i

exteid application server [Build Mumber:Releases 1.0 (031023_17]

3 Select JDBC as the Pools Type.

!, Novell exteNd Application Server Management Console - USER: Anonymous - |EI|1|

File “iew Help

2 & & B 7 9 o EX Novell

@ localhost:80 General  Advanced  Pools  Datab commoctt

Select poal type from list prior to adding & new pool.

2 Add...
4| ExpressPortal

& Samplessn Edit

[

LrElete

Start

12 Novell exteNd 5 Guided Tour
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Click Add.
Select MySQL as the Database Platform from the dropdown list.

If not already selected, select the MySQL JDBC driver from the Driver Set dropdown list.

Add JDBC Connection Pool x|

Select method for specifying connection settings:

i Pre-configured extehld Settings i User-specified Seftings

- Choose pre-configured extehld seftings:

Databasze Platfarm:
MySaL =l

Driver set:

L JDEC driver

LDS Key:
MvSQLY2

Wersion:

o

< Back MNext > Cancel

Click Next.

Type UserInfoRequest in the Pool Name text box.

The complete pool name for a JINDI lookup will be JDBC/UserInfoRequest.

Type uiregadmin in both the User Name and Password text boxes.

Add JDBC Connection Pool x|

Pool Mame:

Enter the pool name, user
id and password to be
Uzer hame: Pazsword: used.

Pireqadmin r(aaaaaaa“

Also specify if the
connection pool wil
participate in glabal
transactions (default is
truey. If true, specify if pool
optimization is to be used.

[ Glokal Transaction (XA I~ COptirize Connection Poaling

< Back Next > Cancel

Click Next.
The JDBC URL template is:

jdbc:mysqgl://%HOST%:%$PORT%/$DBNAMES ?profileSgl=false&maxRows=0

Change the variables in the template as follows:

+ Change %HOST% to localhost.

o Change %PORT% to 63306.

+ Change % DBNAME% to userinforequestappdb.
The URL should read:

jdbc:mysqgl://localhost:63306/userinforequestappdb?profileSgl=false&maxRows=0

Getting Started

13



Add JDBC Connection Pool x|

JDEC Criver: Enter the JDBEC driver
kom.mysql.jdbc.Driver seftings. See your JDBC
driver manual for more
information.Far the JDBC
UEL, substitute the %...%
JDBC URL sttriutes: parts with the appropriate
| pieces of infarmation.

JDEC URL:

ldbc: mysgl Mocalhost: 633060zerinforequestappdb Pprofile

< Back MNext > Cancel

12 Click Next.

13 Click Next on the Optional Connection Pool Properties dialog.

14 Accept the default connection pool manager properties by clicking Finish.
15 Close the SMC application by selecting File>Exit.

EXERCISE 1-5: Start the exteNd LDAP directory server

The Novell exteNd LDAP directory server is the data source that will be used by the exteNd Composer
Web Service you will complete in the next lesson. exteNd LDAP is a simple LDAP directory
implementation that provides an LDAP server to be used by developers for development and testing.

1  Start the LDAP server by going to the Start>Programs>Novell exteNd 5.2>Tools and clicking
LDAP Utility.

-_— - qrny e
L4 @ Accessoties L4 @ Director L4
Documents L4 @ Startup L4 @ Messaging Platfarm L4

Search » (3 winzip QA Tools i LDAP Ukilicy l
Help ﬂ Acrobat Reader 5.1 @ Web Services SDK
n

. (B A Amimickuabiiin Tanle b BB Nuadick Pocs mankakian

Iz

!

_% Settings 4 @ Internet Explorer @ MySQL
&

<

=1

2 Minimize the Novell exteNd LDAP Utility window by clicking the Minimize icon.

< LDAP Utility Sent-7 Re B[]

MNovell exteNd LDAP Utility
LDAP Liility is listening on port 50389
Build 20031121

This tool is to be used for development purposes onhy
Use Novell eDirectory for production environments

copyright @ 2003 Nowell, Inc. All rights resenved. ﬂ

Next lesson In the next lesson you will complete an exteNd Composer service that you will later
deploy as a Web Service.
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Completing the exteNd Composer Project

About this lesson

What is exteNd Composer?

Novell exteNd Composer is a development (and runtime) environment for the rapid design and
deployment of Web Services and XML integration to applications—applications that can connect to
diverse back-end (legacy) systems and data sources. exteNd Composer offers a flexible, intuitive, point-
and-click GUI (graphical user interface), giving the business analyst or application developer a powerful
tool for creating robust XML integration solutions in minimum time.

Objective

This project provides an exteNd Composer component that extracts information from an LDAP
directory. The component (using the LDAP Connect) provides basic user information such as name,
phone, and title. In this lesson you will complete the application by completing an exteNd Composer
service for later deployment as a Web Service. The Web Service will receive a request with a user ID and
provide the information supplied by the component.

What you will do

© 0 NO G h ON=

Review the LDAP component

Test the component

Start exteNd Composer and open the project

Sidebar: the exteNd Composer Component Editor Layout
View the input and output documents for the LDAP component
View the LDAP connection resource

Review the Action Model

Complete the Action Model for the service
Create the Web Services Definition Language (WSDL)

EXERCISE 2-1: Start exteNd Composer and open the project

1  Start exteNd Composer by going to the Start>Programs>Novell exteNd 5.2>Composer menu
and selecting Composer Designer.

By windows Update L

E Programs
@ Docurnents
Bl Sattinns

L4 @ Accessoties

L4 @ Startup

b R Tnbernet Frnlarer

@ AppServer L
& Composer

L4 E Composer Tukorial

L4 @ Directar & Composer Designer
L4 @ MySQL ¥ Composer Server Console
[B Maczaninn Platfarm »
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In the interest of time, you will use a template project that has some of the artifacts you need
already coded. You will review some of the artifacts and complete the steps required to finish this
part of the application.

2 Open the project by selecting menu File>Open Project.

x|
Project File:
.
Help

3 Navigate to the project folder by clicking the Browse button. The project folder is:
D:\GuidedTour\template\RequestUserInfoProject\UserInfoProject.

x|

|_| UserlnfoProject

V| Bk s

Recent

1 il
| composer
| staging

Userinfo spf

'_lserlnfo.spf

IPl'oject Files (* xcp, *.spf)

|Z| Cancel

4 Select the project file UserInfo.spf and click OK.
5 Click OK.

EXERCISE 2-2: Review the LDAP component

In this exercise you will review the component that retrieves the information from the exteNd LDAP
server. This component was created using exteNd Composer LDAP Connect.

1 In the Category Pane of the Navigation Pane, select Component and then LDAP.

= a Component |—|

28 Joec

& EE

0L HML map
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component in the Editor Pane.

ExtENd Composer: UserInfo [LDAP: RequestUserInfo]

File Edit Miew Component Action Animate Tools

SILUPAX IS AT

Window

Help

In the Detail Pane of the Navigation Pane, double-click RequestUserInfo. This opens the

BER
=y Jeivacinmnian

5250 Logan

5260 Termina

CICS RPC

D3 Lagan

DG Terminal

EDI

HP3000 Logan

HFa000 Tarrinal

HThL

JODEC

JhiS

L1Dap !

A

rPEeEEEREON

vl

[2]

)| Moditiec |
This Oct 23

}

[_Nalne

DumpLdapinto

Reguestizerinto Tue Moy 0«

|@ Project

! Tue Mov 04 11:16:06 C5T 2003

" % Requestlserinfo ]

@ Input

Data 0 x

=}-<> UserinfoRequest

< ¥ming
<> UserlD

http:iflocalhostRequestl
S8pade

@ Output

Data 0 x

E-<> UzerinfoRespons
G Eming
<> lgerlD
<> LastMame
<> Firsthlame
<> |nitial
<>WorkPhone
<> Title
<> Department

|@‘ Output J{‘C,‘4§ watch | + Todo][ < Find]

hitp:flocalhostRequestl

(=]
EHED -8 %
Novell
|‘ Tree | Schema |
LDAP Ertries:
(¥ &2 novell

[ &2 zchama

SEEE2OIN
ﬂ’ LOG “Debug: Entry into RequestUserinfo LDAP Component, inj
;’@ Create DSML Search Request: SldapReguestbatchRequest
@" LG "Debug: RequestUserinfo LDAP Component, DSML reque B
f@ Execute DShL Request $idapRequestbatchRequest Response
7 LOG "Debug: RequestUserinfo LDAP Component, DSML respo

=) 7T, IF IdapResponse. XPath{"batchR:

[=}- TRUE
Jf LDAP request was successful.
=} 7T, IF IdapRy XPath({"batchRi
=} TRUE

[~]

chRy

chRespo

[~

S S

2]

! Peady

'Schema loaded

EXERCISE 2-3: Sidebar: the exteNd Composer Component Editor Layout

Now you will take a look at the exteNd Composer functionality that allows you to quickly build and test
solutions that access legacy data sources.

Step 2 of the previous exercise shows the exteNd Composer Designer with an LDAP Component open in
the Editor panel. The Editor Pane is divided into three subpanes:

*

In the XML Documents or DOM Pane (DOM stands for Document Object Model), you can view

and edit the XML documents being manipulated by the component. To make it easier to work with
the exteNd Composer Designer, you can control which of these DOMs are visible at any time.

Completing the exteNd Composer Project
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H Input Data O x
[=-<> UserinfoRequest

4 ¥mins hitp:iflocalhostRequesty

<> UserlD SSpade
‘= ldapRequest |Data O x
/= ldapResponse |Data O x
@ Output Data ax
E=>

4 ¥mins hitp:iflocalhostRequesty

<> UserD

<> Lasthame

<> Firsthlame

< > |nitial

<>YyorkPhone

<> Title

<> Department

+ The Native Environment Pane is used by the Novell exteNd Connect products to provide a native
view into the data source for which the exteNd Connect product provides the integration interface.
So in exteNd LDAP Connect you see a graphical view of the Directory tree.

[ Tree |[schema|
LOAP Entries:
=) & novell [
=& admin
= 8 HR
GFranks
I RSimpsan

I SE8pade

[>]

[E3REaRES]

=
|

R and D

Sales

daiad

R

+ Inthe Action Model pane, you work with the exteNd Composer actions associated with the current
component.

SEBEZOI
g
@" LOG "Debug: Entry into RequestUserinfo LDAP Component, in
.?@ Create DSML Search Request: $ldapRequestbatchRequest
@" LOG "Debug: RequestUserinfo LDAP Component, DSML reque
f@ Execute DSML Reguest $ldapRequestbatchRequest Response
@" LOG "Debug: RequestUserinfo LDAP Component, DSML respo
=} 7T, IF IdapResponse. XPath{"batchResy chRes|
= TRUE
J¥ LDAP request was successful.
=} 7T, IF IdapResponse.XPath{"batchResponseisearchRespo
= TRUE
£ I B

An exteNd Composer action is similar to a programming statement. It takes input in the form of
parameters and performs specific tasks.

An exteNd Composer component consists of a set of instructions for processing XML documents
or communicating with non-XML data sources. This set of instructions is called an Action Model.
In exteNd Composer components and services, the Action Model performs all data mapping, data
transformation, and data transfer tasks.
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Action Model toolbar

The toolbar above the Action Model gives you access to exteNd

Composer’s animation tools. These tools allow you to test and troubleshoot the actions associated
with your services and components. You can step through a service or component Action Model
one step at a time and see the result of each action. By doing this, you will become aware of any
action failures as well as be able to verify that the output of the component is what you expected.

The animation tools allow you to set breakpoints so you can test individual sections of an Action
Model. Using breakpoints, you can easily troubleshoot an Action Model by stopping execution just
before any action that is causing trouble, and stepping through that and subsequent actions one at a

time.

Button Tool What it does

e Start Animation Starts the animation process.

End Animation Stops the animation process.

=) Step Into Executes the currently selected action and
highlights the next sequential action. If the
currently selected action is a Component,
Repeat, Decision, or Try/On Error action, the
next highlighted action becomes the details of
those actions.

B Step Over Executes the currently selected action and
highlights the next sequential action. Unlike the
Step Into button, clicking this button does not
highlight and execute the details of Component,
Repeat, Decision, or Try/On Fault actions.

@ Toggle Sets the highlighted action in the Action Model

Breakpoint as a breakpoint. You may set more than one

breakpoint.

B Run To Runs the animation to the next breakpoint or to

Breakpoint/End the end of the Action Model.
i Pause Animation  Pauses the animation.

EXERCISE 2-4: View the input and output documents for the LDAP component

The Input XML document is an XML template containing a sample of the data required to make a request
for user information. You use this template as a guide for writing the Action Model and testing the

execution of the model.

H Input Data O x
[=-<> UserinfoRequest
4 ¥mins hitp:iflocalhostRequesty
<> UserlD SSpade

The Output XML document is also an XML template. It contains a sample of the data that will be

provided to fulfill the request.
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F output Data O x

<> UserinfoRespons
4 ¥mins hitp:iflocalhostRequesty
<> serlD
<> LastMame
<> FirstMame
<> |nitial
<>iorkPhone
<>Title
<> Department

The sample of the Output XML is what is sent if the component is successful in connecting to the
directory and finding the requested user information. If the user does not exist, an error message is sent.
You will now view the sample data and the XML structure in the Output XML document.

1  In the Output XML document in the Component Editor, right-click to open the context menu.

! Wiew 3
Launch Editor
Load XML Sample...
Save XML As...

1 Find...
Find Mext
Validate

2 Seclect Load XML Sample.
3 Click the Sample dropdown list then select UserInfoResponse message.xml.

Load XML Sample x|

Part:

Joutput [v]

(_) File Mame

(®) Sample

UzerinfoResponse _emtpy xml [~] [ Default

LizerinfoResponse_data xml
——U=zerinfoResponse_ermtpy xml

ﬁUserlnfoResponse_message.me 0K Cancel

4 Click OK.
& Output Diata O x
<> UserinfoRespons
4 ¥mins hitp:iflocalhostRequesty
<> MWessage test

EXERCISE 2-5: View the LDAP connection resource

20

The LDAP component requires a connection resource to connect to an LDAP server. The connection
resource provides the specific information required to establish a connection to the exteNd LDAP
directory server you are using. Now you will view the resource used by this component.
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1 From the menu bar select File>Properties.
2 Select the Connection Info tab.

Properties ﬂ

| Header Info || Messages | Connection Info]

Connection |Userlnf0LdapServer |L|

Host or IP Address I

R R

Port Mumber I

Base DN I

User DN I

R R

Password i

Wersion I

Use TLS

Time Limit |

size Limit |

The Connection Info tab provides the information for the connection resource being used in a read-
only mode. By clicking the Test button you can verify that a connection to the exteNd LDAP server
can be established. Note the icon next to some of the field values: this indicates that an
ECMAScript expression is used to create the required value. The actual values are stored as project
variables in your project, where you can easily change them in one place or even dynamically
before the component is executed.

3 Click OK to close the dialog.

EXERCISE 2-6: Review the Action Model

The Action Model is the collection of instructions that are executed in sequence to process the input to
produce the output. In this exercise you will review some of the key actions in the LDAP component that
will be executed by the Web Service you are going to complete.

SHEEE2O I
g
@" LOG "Debug: Entry into RequestUserinfo LDAP Component, in
.?@ Create DSML Search Request: $ldapRequestbatchRequest
@" LOG "Debug: RequestUserinfo LDAP Component, DSML reque N
f@ Execute DSML Reguest $ldapRequestbatchRequest Response
@" LOG "Debug: RequestUserinfo LDAP Component, DSML respo
=} 7T, IF IdapResponse. XPath{"batchResy chRes|
= TRUE
J¥ LDAP request was successful.
=} 7T, IF IdapResponse.XPath{"batchResponseisearchRespo
- TRUE [~
<] G

Log actions

The first, third, and fifth actions are Log actions used to report debug-level information. This logging can
be turned on by setting exteNd Composer’s Designer or Server Log threshold. After deployment to an
application server, these Log actions may be helpful in tracking down problems with a deployed
application. It is good development practice to be proactive about adding them to your code. If you want
to see the results of the debug Log actions in this project, you must set the Log Threshold in the
Preferences to 4 or lower.
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@" L0 "Debug: Entry into RequestUserinfo LDAP Component, input is:'n™ + Input TO Systern Output using Log Level 4

Create DSML Search Request action

The second action is a Create DSML Search Request action, used to create an LDAP request as a
DSML XML document. This action creates the actual query details (the where clause) and identifies the
attributes that are to be returned.

.?@ Create DSML Search Request: $ldapRequestbatchRequest

When you select this action, the Native Environment Pane allows you to review and edit the details of the
search request. The UserID in the Input XML Document is used to query the uid attribute in the directory.

| search | Fitters ]| Attributes || Tree || Schema |

dp mm {qp e}
bbjedclass [v] = % r'inetOrgPerson" [v]| And &
Pid [v] = % ["UserinfoRequestizeriD”) End %

The result of executing this action is an XML document that is placed in a temporary XML DOM.
Now you will view this document in the XML Documents panel.

1 Right-click in the XML Document panel, select the Add to Display submenu, and select
IdapRequest. This is the temporary XML DOM used to hold the XML created by the Create
DSML Action.

‘= ldapRequest |Data O x

2 Inthe Action Model, select the Create DSML Search action.

.?@ reate DSML Search Request: $ldapRd

3 Click the Execute Current Action icon ® on the toolbar. This executes the action and displays
the XML created for the request in the XML Document panel.

@ ldapRequest Data O x
(=)< > hatchRegquest
< ymins urn:nasis:names:itc:DSMLZ:0:core
=) <> searchRequest
< dereffliases derefAlways
< dn o=novell
<y scope wholeSubtree
< typesOnly false
(=)< >filter
[+-<>and
B tiribute s
[+ <> attribute
[+ <> attribute
[+ <> attribute
[+ <> attribute
[+ <> attribute |
(2} <> attribute [v]
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4 Now click the Execute All icon ®  on the toolbar. This causes the entire component to be
executed, providing you the results of a successful query.

5 Click OK at the Execution Completed message dialog.

Execute DSML Request action

The fourth action is an Execute DSML Request action. This action takes the request created by the
Create DSML Search Request action and connects to the server to execute the request. The result is
placed into another temporary XML document called ldapResponse.

f@ Execute DSML Reguest $ldapRequestbatchRequest Response: $ldapRest hatchResy

Here is what the Native Environment Pane looks like when the action is selected, after execution:

[ Request| Response | Tree|( schemal
@® DSMLResponse Data
BE = atchResponse]
< ymins urn:nasis:names:itc:DSML2
=} <> zearchResponse
< requestiD 11

[+ <> searchResultEntry
[+ <> searchResultDone

Here is the 1dapResponse XML document.

@ IdapResponse Data O x

o} <> patchResponse |~
< ymins urn:nasis:names:itc:DSMLZ:0:core
=} <> zearchResponse
< requestiD 11
(=) <> searchResultEntry
< dn cn=58pade, ou=HR, o=novell
< requestiD 11

()2 attr

()< > attr

()2 attr

()< > attr

()< > attr
IBR=d:carchResultDone
< matchedDM o=novell

< requestiD 11
[+ = racult™ado

[~

+ Use the steps you learned above to make the IdapResponse XML document visible.

Decision action

The sixth action is a Decision (IF) action. This action checks for a successful request. If the request is
successful, the TRUE block of actions will be executed. This sequence of actions is used to produce the

required output you saw in the Output XML Document earlier.

First the XML document is created with no data to ensure that the structure of the XML document
conforms to the schema. exteNd Composer will always create well-formed XML, but it is your
responsibility to ensure that the XML is valid when an XML Schema or DTD is specified.

Completing the exteNd Composer Project
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SRR |dapResponse.XPath("batchResponse/searchResponse/searchResultDoneresultCode/@code™]
= TRUE
J¥ LDAP request was successful.
=} 7T, IF IdapResponse.XPath{"bhatchRest chResy chResultEntry™).exists()

= TRUE
J¥ The requested user ID was found in the directory.
__xf’_x" Build empty response to fill in with returned results, because all elements must he
ﬁ MAF ™ TO $OutputUserinfoResponselUserlD
ﬁ MAF ™ TO $OutputUserinfoResponseLastName
ﬁ MAF ™ TO $OutputUserinfoResponseFirstName
ﬁ MAF ™ TO $OutputUserinfoResponseinitial
ﬁ MAF ™ TO $OutputUserinfoResponseWorkPhone
ﬁ MAF ™ TO $OutputUserinfoResponseTitle
ﬁ MAF ™ TO $OutputUserinfoResponseDepartment

The next step is to handle each of the attributes returned in the result and place the data in the XML
document. The DSML response will contain a repeating element for each of the attributes that was
requested and is available for that specific entry in the directory. The Action Model must loop through
each of these repeating elements and check the attribute name, placing the value into the correct element
in the output XML document.

EF MAF 10 $OutputiUserintoHesponseepartment
= G FOR EACH attr REFRESENTING $ldapRest hatchResy chR:
=} Loop Action
= ?E SWITCH attr.XPath("@name")
=} CASE: "cn"
ﬁ MAP $attrivalue TO $respilseriD
-} CASE: "sn"
ﬁ MAF $attrivalue TO $resplLastName
[} CASE: "givenName"
ﬁ MAF $attrivalue TO $respFirstName
[=}- CASE: "initials"
&5 MAP $attrivalue TO $respinitial

The FALSE blocks of the Decision actions contain Map actions that create message structures used in
the event of failure, and a Log action used to log the failure of an LDAP request.

=} FALSE
J¥ Reguested user ID was not found.
ﬁ MAF "Requested userlD: ™ + Input.XPath{"UserinfoRequestUserlD™) + * not found." T.
=] FALSE
J¥ LDAP request was failed.
ﬁ MAF “LDAP request failed with code: * + ldapResponse.XPath{"batchResponse/searchRes
@" LOG “Error: RequestUserinfo LDAP Component, DSML request failed with following error:in

Apply Namespace action

The final action is an Apply Namespace action that adds a reference to the XML Schema namespace that
can be used to validate this document.
B e eree s eraqumsrerusrirers seeres airs s wrersssfrresirres e reTee s AJSAers siemrires Suees srerssaseresy ares e s as
ns: Apply MameSpaces For Output as { | hitp:Mocalhost/RequestUserinfoiresourcesischemas/Userl
@" LOG "Debug: Exit from RequestUserinfo LDAP Component, output is:in™ + Output TO System Outpulj

EXERCISE 2-7: Test the component

With the exteNd Composer Designer, you can test the execution of the component without having to
deploy to a J2EE application server. You will now test the component—first with a valid user ID and then
with an invalid ID.
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1 The valid user ID is already provided for in the default XML Input sample. Click the Execute All

icon ® on the toolbar.
2 Click OK for the Execution Completed message dialog.
3 Review the Output XML Document.

F output Data O x
E-<> UserinfoRespons)
4 ¥mins hitp:iflocalhostRequesty
<> UserlD SSpade

<> LastMame Spade
<> FirstNarme Sam

< > |nitial

<>'WorkPhone  |555-B67-7598
<> Title Security Manager
<> Department

4 To enter an invalid User ID you need to change the Input sample. Double-click the value SSpade.
x

SInputfUserInfoRequest /UseriD

FSpade

5 Type xxx replacing SSpade.
6 Click OK.

7  Click the Execute All icon ® on the toolbar.
8 Click OK for the Execution Completed message dialog.
9 Review the Output XML Document.

F output Data O x
FI <> ..................................................
4 ¥mins hitp:iflocalhostRequesty
<> Message Requested userlD: e n

You have now finished reviewing the LDAP component. To close the LDAP component:
10 Click on the Close icon in the editor to close the component.

HE - &
Cloze document frame

11 If prompted to save changes, Click No.

EXERCISE 2-8: Complete the Action Model for the service

With exteNd Composer, a service is required to act as the interface to the outside world. An application
that uses the LDAP component you reviewed must invoke a service through a Service Trigger (more on
this later) that will execute the component or even possibly other components. A service has its own
Action Model. In this exercise you will complete the service that accepts the requested user ID and
returns the information supplied by the RequestUserInfo component.

1 In the Category Pane of the Navigation Pane, select Service and then Web Service.

[~]
= &% ramnanent ‘_‘
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Although the service you selected is classified as a Web Service, it does not necessarily mean that it
has a WSDL and SOAP binding. It is a Web Service only in the sense that it will normally be

invoked as part of a Web application and that it responds to the request/response model used with
HTTP.

The service trigger (or triggers) for invoking the service are created when it is deployed to a J2EE
application server (like the Novell exteNd Application Server). One of the deployment options
available to you is to use a Web Service with a WSDL and SOAP binding.

In the Detail Pane of the Navigation Pane, double-click ViewUserInfo. This opens the service in
the Editor Pane.

|' 25 viewllserInfo ]

H Input Data Ox @ output Data O x
= <> UserinfoReguest = <> UserinfoResponse
4 ¥mins hitp:iflocalhostRequesty 4 ¥mins hitpaiflocalhostRequestUserinfolresaol
<> UserlD SSpade <> Message test

SEABRFEZO I

=
@" LOG "Debug: Service: Request received'in™ + Input TO Systermn Cutput using Log Level 4
S TRY
EXECUTE
(=} All ather Faults
J¥ Hopefully this never hapt but if it does we catch, report, and still respond.

@" LOG "Debug: Service: Response returned:n” + Output TO Systerm Cutput using Log Level 4

Note that the XML Output sample used for the service is the message response. This was set as the
default because the service will normally take the output produced by the LDAP component as its
output. But in the event that the component fails to execute for any reason, the service will respond
with a message.

F output Data O x
= <> UserinfoResponse
4 ¥mins hitpaiflocalhostRequestUserinfolresaol
<> Message test

The Action Model for the service has been partially completed for you. The Try On Fault action is
a wrapper for the execution of the component; if it fails, the Fault section will be executed and a
Log action will send a log message to the System Output. You will add the action to execute the
RequestUserInfo component and a Map action to create the XML output in the event of a fault.
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3
a4
5

@ TRY

EXECUTE

(= All other Faults

/7 Hop

SEBEEO N
=

fully this never hapy

Select the EXECUTE in the TRY action.
Right-click to display the context menu. Then select New Action>Component.

In the Component dialog, enter the following:

+ Component Type: LDAP

+ Component Name: RequestUserInfo

+ Passed Part: Input
+ Returned Part: Output

W LOG "Debug: Service: Request received'in™ + Input TO Systermn Cutput using Log Level 4

but if it does we catch, report, and still respond.
W LOG "Debug: Service: Response returned:n” + Output TO Systerm Cutput using Log Level 4

componene x
(®) Predefined (23 Dynamic

Component Type

Component Mame

ILDAP |Z| IReques{Userlnfo |Z|
Passed Part(s) I To Part I Template Category I Template MName I
Input |In|Jut |IJserData |F’.ec|uest |
Returned Part(s) I From Part I Template Category I Template MName I
Outout |Out|:|ut |IJserData |Response |

Click OK.

=} EXECUTE

% xecute RequestUserinfo Passilnput) Return {Output)

(=) All other Faults

Select All other Faults of the Try/On Fault action.

Right-click to display the context menu. Then select New Action>Map (or use the keyboard
shortcut Ctrl+M).

Mee x|
Source
|Z| (C) Expression:

| )74
Options

O O | O |
Target

(@) WPath: k)utput |Z| (C) Expression:

| )74
Appty 0K [ cancet |
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9 In the Source area click the Expression radio button, then click the ECMA Expression icon E 1o
open the expression editor.

x|
“arighles: FunctionsMethods: Operators:

[F-<<> Input [#}-Custom Scripts [*}-Math

[+}-=<> Output [*}-Document [*}-Relational

[*} <> _SystemFault [*}- ECMAScript [#}-Logical

[*}-<<> PROJECT [*}-Extended ECMAScript [+}-String

[} << > Repeat Aliases [} LDAP Script

[} << > Node Aliases

[ validate || ok | cancel |
10 Type the following (include the quotes):

"Error in component " + _SystemFault.XPath("m:FaultInfo/m:ComponentName") + "
at " + _SystemFault.XPath("m:FaultInfo/m:DateTime") + " with MainCode " +
_SystemFault.XPath("m:FaultInfo/m:MainCode") + ", SubCode " +
_SystemFault.XPath("m:FaultInfo/m:SubCode") + ", and with a message of " +
_SystemFault.XPath("m:FaultInfo/m:Message") + """

_SystemFault is a Composer DOM variable that holds an XML document in the event that a system
fault occurs. If you had forced a fault during the execution of the service (by stopping your exteNd

LDAP server, for example), you could view the structure of this document in the expression editor.
You would do this by clicking the icon next to _SystemFault.

When you double-click an XML element in a DOM variable such as _SystemFault, the expression
editor writes the appropriate ECMAScript expression—for example:
_SystemFault. XPath("FaultInfo/DateTime").

11 Click OK.
12 In the Target text box, type UserInfoResponse/Message (or use the expression editor by clicking
the icon.
Mep x|
Source
) WPath: I D (®) Expression:

1d with a message of " + _SystemFault XPath("m:Faultinfo/m:Message") +"" @ o

Options

Of | ol | O |

Target

(®) XPath: k)utput () Expression:
|User|nf0Response.fMessage @

Apply | ok [ Cancel ]
13 Click OK.
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14 To place the Map action after the Comment action, you can drag and drop. Left-click the Map
Action, hold it and drag it down to the Comment Action. Then release the left mouse button.

SEABRFEZO I

= viewUserlnfo

@" LOG "Debug: Service: Request received'in™ + Input TO Systermn Cutput using Log Level 4

S TRY

[} EXECUTE

% Execute RequestUserinfo P {Input) Return (Output)
(= All other Faults

J¥ Hopefully this never hapt but if it does we catch, report, and still respond.
ﬁ AP “Error in component * + _SystemFault. XPath{"Faultinfo/ComponentName™) + " at " + _SystemFault.XPat
@" LOG "Debug: Service: Response returned:n” + Output TO Systerm Cutput using Log Level 4

<] | B

15 Click the Execute All icon ®  on the toolbar.
16 Click OK for the Execution Completed message dialog.
17 Review the Output XML Document.

F output Data O x
= <> ...........................................
4 ¥mins hitp:iflocalhostRequesty
<> UserlD SSpade

<> LastMame Spade
<> FirstNarme Sam
< > |nitial
<>'WorkPhone  |555-B67-7598
<> Title Security Manager
<> Department

18 Click the Close icon in the editor to close the service.

HE - &
Cloze document frame

19 If prompted to save changes, click Yes.

EXERCISE 2-9: Create the Web Services Definition Language (WSDL)

Now that the service is completed and tested, your next task is to create a WSDL for the service. You need
to do this because you will be deploying this service as a Web Service, and the WSDL is required for the

service trigger that will be generated. The WSDL will also be used to help build the user interface for the
application in Lesson 4.

1 In the Category Pane of the Navigation Pane, select Resource and then WSDL.

Custom Script [~]
EDI Document het
EDI Interchange hi
Terminal StyleShen

§ S EuAN
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2 Right-click to display the context menu, then select New.

Create a New WS5DL Resource ﬂ

To select one or more WSDL files from yaour file systemn to be Composer WSDL resources, use Browse or
type ane or more paths separated by a semi-calon ¢). Then use the WSDL to automatically drive W5

Interchange actions in a campanent.

(®) Create from existing external file(s) (_) Create using the Composer Editor

File/URL to Import:

}‘Iﬂp:.l’.l’<h03‘t>:<p0r‘t>.l’<path>

Hel, | [ Finish ][ cancel

3 Select the Create using Composer Editor radio button.

4 Type ViewUserInfo in the Name text box.

5 Type Describes the Web Services descriptor for the LDAP user information request service in
the Description text box.

Create a New WS5DL Resource ﬂ

WSDL descriptions can be automatically generated for your Services and published to various Web Service
Registries. WS5DL is also used to automatically configure Web Service Interchange actions in a component.
Enter a name and description for this WSDL resource. The name is required and may not contain the
characters: [:7 "= = | Names are case insensitive {i.e. MyOhjectMame is the same as myohjectname).

(C) Create from existing external file(s) (®) Create using the Composer Editor

IHame:

t\liewUserInfo

Description:

Descrines the Web Services descriptor for the LDAP user information request service

” Next > ][ Cancel

30 Novell exteNd 5 Guided Tour



6 Click Next.
x

Check ‘Associate Web Service'to automatically create WSDL for a Service in this project, or uncheck itto
manually create your awn. (Mote: If noWeb Services exist, this checkbox is disabled) Use 'Document' style
when passing XML business documents between Weh Services and 'RPC' for passing flat parameter lists
as XML to a program deployed as a'Web Service.

Associate Web Service

Service ITestViewUserInfo
Binding Style:  (®) Document (IRPC

[ Generate SOAP Service

Hel, [ <Back |[ Finish ][ cancel

7 Select ViewUserInfo from the Service dropdown list.
8 Sclect the Generate SOAP Service check box.
9 Type http://localhost:80/RequestUserInfo/viewOnly in the URL text box.

Create a New WS5DL Resource ﬂ

Check ‘Associate Web Service'to automatically create WSDL for a Service in this project, or uncheck itto
manually create your awn. (Mote: If noWeb Services exist, this checkbox is disabled) Use 'Document' style
when passing XML business documents between Weh Services and 'RPC' for passing flat parameter lists
as XML to a program deployed as a'Web Service.

Associate Web Service

Service IViewUserInfo
Binding Style:  (®) Document (IRPC

Generate SOAP Service

LRL }1ttp:.l’.l'loc:alhostSD.fRequestUSErlnfoNiEWOnly

Hel, <Back |[ Finish ][ Cancel

10 Click Finish.
11 If prompted with a message, click OK.
12 Click the Close document frame icon in the editor to close the WSDL.

HE - &
Cloze document frame

You have now finished creating the exteNd Composer Web Service.

Next lesson In the next lesson you will create a service trigger for the service, then deploy and test the
service.
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Deploying and Testing the Web Service

About this lesson

Objective

The exteNd Composer project you just worked in Lesson 2 is part of an exteNd Director project. exteNd
Composer is being used as the data layer of the application, and exteNd Director will be used for the
presentation layer. Through cleanly separating the two layers, changes may be made to one without
necessarily requiring changes in the other.

In this lesson you are going to create a service trigger for the exteNd Composer service you completed,
deploy the application, then use exteNd Composer to test the SOAP interface to the service.

What you will do
1  Start exteNd Director and open the project
Create a SOAP-based service trigger
Sidebar: the exteNd Director development environment

Deploy the application

a b O®N

Test the Web Service using exteNd Composer

EXERCISE 3-1: Start exteNd Director and open the project

In the interest of time, you will use a template project that has some of the artifacts you need already
completed, including the addition of the exteNd Composer project. In Lesson 4, “Completing the exteNd
Director Project”, you will be reviewing some of these artifacts. When you have completed the required
artifacts, you will test the completed application.

1  Start exteNd Director by going to the Start>Programs>Novell exteNd 5.2>Director menu and
selecting Director Designer:

= AppServer
-l @ Composer
E Programs L4 @ Accessories 4 E Direckar
@ Documents 4 @ Startup 4 @ Messaging Platform
_% Settings 4 @ Internet Explorer @ MySQL
An o NI I

% ‘Windows Update

irectn arbe Cogrdi
@ Director Designer

2 Open the project by selecting File>Open Project.

3 Navigate to the project folder by clicking on the Look in dropdown list. The project folder is
D:\GuidedTour\template\RequestUserInfoProject:

Look jr: I@ FequestUserlnfoProject j =
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4 Select the project file RequestUserInfo.spf, then click Open:

~

Look jr: I@ FequestUserlnfoProject j = EF '

tRequestUserInfo,spf
E;% RequestUserInfo-resource, spf

File name: IHequestU zerlnfo.spf j Open I
Files of type: IProiect Files [*.zpf] | Cancel |
7

| Wiew using: I.\\rchi\te layout |i|

Change the view
view.

in the Navigation Pane to the archive layout

What you see in archive layout view This view is a structural view of the archive that will be
deployed to the server. It shows you where the various artifacts in your project will be placed in the
archive. The default view is source layout, which shows you where the artifacts are actually stored
in the development file system. In J2EE, where things are placed in the archive is important.

All the artifacts of the exteNd Composer and exteNd Director projects are stored as files in folders
located relative to the project file you opened.

The resource set One of the features of exteNd Director that helps cut down on the amount of
developer time required in testing—by reducing the number of deployments required—is the
resource set. (For more details on the resource set, see the chapter on using the resource set in an
exteNd Director application in Developing exteNd Director Applications.)

An exteNd Director project has a configuration file called resourceset.xml, and for the resource set
to be used properly in exteNd Director and the exteNd Application Server (or any other application
server), a variable in the file must point to the project’s physical location on your drive.

Now you will adjust this variable, because the current location of your project is most likely
different from the location used to create the project initially.

In the Folder Pane of the Navigation Pane, click the ® icon next to the WEB-INF folder.
Select the conf folder.

Double-click the resourceset.xml file in the Detail Pane of the Navigation Pane to open the file in
the Editor Pane:

Wiew using: IArchivE layout [~ [ resourceset.xml \Xl]
g & Requestliserinfo.spf [ General ]f Variables [ Resource Path || Lib Path [ Directaries| |
[ images
3 javascript Iame; IRBques‘tUserlnfo-RasourceS-
(O pages Dynamic Class Loading: IErUe |~
[=H = WEB-INF —
B3 dasses Validate: Ifalse |~]
b Verbose: [falze [~]
= conf
[ tag Vultures: rUe |i|
ﬂ Resource Set Utilities:
D config.xml 'l
D resourceset xml
D services xml
<]

g Directory @ Project
[ G’\‘} Registries JL ﬁ Resources

ll}h Graphical View J[@ XML Source WE“‘JL?ZE AML Tree \IiewJ
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In the Editor Pane, click the Variables tab.

10 Locate the WARLOCATION key and change its Value to point to the physical location where you
placed the template project—for example: D:\GuidedTour\template\RequestUserInfoProject.

ey | “alue
WARLOCATIOR |D NGuidedTouritemplate\RequestUser infoP roject

11 Press Enter to save the change:

12 Click the B toolbar icon to save your changes.

13 In the Editor pane, click the General tab.

14 Scroll down until you see the Restart button. Click the Restart button.
[

[ = Stop ” |]D Start "e Restart ”@ Validate ” & Clear ” (!) Enable /Disable Resource Subprojects,. [

w

Pa | T =1

15 Close the open editor by clicking ® the editor title tab [ resourcezetxmi o]

EXERCISE 3-2: Create a SOAP-based service trigger

An exteNd Composer service requires a Java service trigger that will interact with the exteNd Composer
runtime on behalf of the users of the service.The exteNd Composer service you completed will be
invoked as a Web Service using SOAP.

For working with Web Services, you need to have a Java servlet that is listening at the URL specified
when you created the WSDL (you did this in EXERCISE 2-9: “Create the Web Services Definition
Language (WSDL)”).

In this exercise, you are going to configure a generic servlet, provided by exteNd Composer, to listen at
your specified URL.

1 Click the New File icon [2 .
2 Select the Web Services tab.
3 Select the Composer Web Service Wizard:

I_' le X
.j Choose a file type.

Creates a trigger to execute an existing Composer YWeb Service. The wizard prompts you for trigoer type,
target project, and selection of a Composzer Service.

General || Portal || Portlet || Rules | Web Services | Workflow || XML
| Composer Web Service Existing Web Service
Create a trigger for a Composer weh service Use an existing Web Service

New Web Service WSDL
2] Create a new Web Service Create a new WSDL file

5]

4 Click OK.
5 Select Web Service as the Service Trigger Types.
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6 Verify that RequestUserlInfo is the target project:
x

Service Trigger Types

I\M’.b Service |Z|

Target Project

IReques{UserInfc |Z|

If this control is disabled, then there are no projects that
support the selected trigger type.

[ Create WAR project... ]

I Help @

o (v

| cancel |

7 Click Next.
8  Verify that UserlInfo is the project selected.
9 Select ViewUserInfo as the service:

ﬂ Composer Seryice Wizard ﬂ
Composer
Project: IUserInfo
service: |yiswliserinfo
Web Service Details
WsDL: IViewUserInfc
Method: SOAP
LURL:  wiewOnly
I Help @ I < Back ” Next > I Cancel ]

10 Verify that ViewUserInfo is selected as the WSDL in the Web Service Details block. Click Next.
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11 Accept the defaults:
x

Web Service Options

Body Mamespace: |

URL Path: hiewOnIy

Service Mame: I\’iewUserInchervice

[<]

Faort: I\’iewUsel'Inchol‘t

[<]

Operation: IViewUSel'lnchperaﬁon

[<]

Certificate Resource: I<none:=

w

[ Validate Request XML Signature

[ Hetp @ | | <Back |[ Finish || cancel |

12 Click Finish.
13 Click OK for the Composer Deployment Wizard confirmation dialog.

Composer Deployment Wizard ﬂ

The wizard has completed successfully,

The following actions were taken:

. The web xml for project "RequestUserinfo" has been modified.

EXERCISE 3-3: Sidebar: the exteNd Director development environment

The exteNd Director development environment, along with providing you with the ability to visually
create exteNd Director artifacts such as portlets and XForms, is also used to keep track of the J2EE-
specific artifacts and to build and deploy the J2EE archives that make up your project. In this exercise
you will take a slight detour to look at some of the features of exteNd Director that are useful in managing
the development of a Web-based solution.

In the last exercise, when you created an exteNd Composer service trigger, you may have noticed that no
source file was opened. So you may wonder whether you actually have a service trigger or not.

The answer is yes—the exteNd Composer runtime provides a servlet implementation that accepts the
SOAP request, invokes the exteNd Composer service, and formats a SOAP response. This servlet is
configured to invoke the correct exteNd Composer service by setting initialization parameters in the
web.xml (J2EE Web application descriptor) file of the Web archive. Now you will view these entries.
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1 Scroll up the Folder Pane of the Navigation Pane until you see the RequestUserInfo.spf entry for
the project, then select it.

Wiew using: I.\\rchi\te layout [~]

= g RequestUserinfo.spf |
[*H3 data
[FHT images
3 javascript
[ R

2 Right-click to open the Context menu, then select Open Deployment Descriptor.

3 Ifyou get the Select Build Option dialog and do not want to see this dialog again, select No, don't
build now, Never automatically build my project—then click OK:

« Itisusually better to explicitly build your project rather than having it done automatically,
especially when all you want to do at this moment is simply view the descriptor file. When you
deploy your project in a later exercise, the exteNd Director development environment will
check whether a build is required at that point.

+ Youcould also have opened this file by navigating to the WEB-INF folder and selecting it in the
details. The descriptor file is always called web.xml and will always be located in the WEB-
INF folder of the archive.

4 In the Editor Pane, scroll down until you see an entry called
com.novell.composer.userinfo.ViewUserInfoSoapService. This is the servlet configuration.

il Role References

=] com.nouell.composer.userinfo.\l’iewUserInfoSoapSeruice
= v Initialization Parameters

composerdeploymert

SErViCEname

izDocument

encodingUR]

portTypeGiame

ezl _file

operation

requestsigvalidate
‘i Role References

9444444

+ The web.xml file is XML, and the exteNd Director development environment gives you access
to the actual XML. But in most situations you will use the Visual Editor to edit the contents of
this file, providing a more intuitive way to maintain the file. You may view or change elements
in the file by using the right-mouse button to bring up a Property Inspector. The Property
Inspector will show you the valid values for the element you are working on or allow you to
select its values from other entries in the file when you are entering a cross-reference.

+ Ifyou scroll further down you also find a Servlet Mapping entry for this servlet that configures
the proper URL pattern that this instance will use.

5 Close the open editor by clicking on the editor title tab.

For each type of application server, the exteNd Director development environment uses a separate server
profile, which defines the details required for deploying to that type of application server. In this Guided
Tour you are using the default profile, which will deploy to an exteNd Application Server running locally
on your computer. If you want to review this profile or create a new one, use the profile editor available
from Tools>Profiles:
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@ Databases ” Registries |

x

Server Profiles are used at deployment. They specify the information necessary to deploy to a given
server.

Mote: & server type is valid for the server version specified or greater, unless a higher numbered
wersion iz available.

Profile name:  [mMovell exteMd 5_X

|L| lew. ..
Server type: Movell extelld 5%
Server version: 5.1

Delet:
Deployment tools directory:  Ci\Programs\lovellextelld S\AppServeribin Zelete

Rapid Deployment directory: Ci\Programs\lovellextelldS\AppServerwebapps

Server specific information:
Server name: localhost: 80
Database name: SilverMasters0

Cancel

EXERCISE 3-4: Deploy the application

Now you are ready to deploy the application to the exteNd Application Server so that you can test the
exteNd Composer service as a Web Service.

1

4

5

Scroll up the Folder Pane of the Navigation Pane until you see the RequestUserInfo.spf entry for
the project, then select it:

Wiew using: I.\\rchi\te layout [~]

= g RequestUserinfo.spf |
[*H3 data

[FHT images

3 javascript

[ R

Right-click to open the context menu, then select Open Deployment Plan.

The deployment plan defines the server-specific details necessary for successfully deploying the
application to the exteNd Application Server. It is created and maintained based on the information
in the web.xml descriptor file. You should always review and save the deployment plan before
doing a deployment.

TIP: If you are deploying to a different server, you will need to change the server profile used by this
plan.

Click the & toolbar icon to save your changes.

Close the open editor by clicking the ® on the editor title tab.

Click the Deploy toolbar icon B .

When you see Deployment completed successfully in the Output Pane of the exteNd Director
development environment, your deployment has completed.

This first deployment took a little bit longer than is usual, because not only was your application
deployed to the server and then started by the server—but the database was also initialized. This was the
database you created and defined a connection pool for in EXERCISE 1-4: “Create a JDBC connection
pool”.
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endobj
/4 AgMMetaText End

WarErrorPage
/WarExceptionType jawva.lang.Exception
fWarLocation Apages/error.jsp

endob]

[

Completed deployment to the serwer for the WAR RecuestUserInfo(RequestUserInfo.war)
[
Deployment completed successfully.

+ Todo gOutput 4, Find

EXERCISE 3-5: Test the Web Service using exteNd Composer

In the exteNd Composer project there is a service (TestViewUserInfo) that was created to test the
deployed ViewUserInfo as a SOAP service. This service has one action (the WS Interchange) that is used
by exteNd Composer to consume a Web Service that uses SOAP binding. In this exercise you will use
this service to test the application you just deployed.

Set the log threshold

As part of your testing you want to see the output from the Log actions in the Composer Component and
Service to appear on the server console. For this to happen you need to set the log threshold on the server
using the Composer Administrator Console.

1
2
3

Test the Web Service
1

2

Open your favorite browser.
In the address bar, type http://localhost/exteNdComposer/ and press Enter.

Type the exteNd Application Server administrator user ID and password you supplied when you
installed the exteNd 5 Suite, then click OK:

/] enteNd Composer Server Console - Microsoft Internet Explorer

File Edit Wiew Favorites Tools Help

B - | at | Qhsearch [GelFavorites GMedia &4 | N S

Address I@ http: fflocalhost fexkeMdComposer fConsale

exteNd Composer

ElE

3

About Products: Wit Free Memary: 51 Mib
3270 Log Level: |5|
Apply Log Level
' 5250

Change the Log Level to 4, then click Apply Log Level.

Close the browser application by using File>Close.

Open the exteNd Composer Designer. (It should still be open, and using Alt+Tab should get you to
it.)

In the Category Pane of the Navigation Pane, select Web Service under the Service category.
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Double-click TestViewUserInfo to open the service in the Editor Pane.

xtenNd Composer: UserInfo [Web Service: Test¥iewlUserInfo] 18] x|
File Edit Wiew Component Action Animate Tools Window Help EHO -8 x
LEHRG Y AA X |5 S Novell
| = € serice {eg Test\«’iewUserInfo]
JMS Service
l 'S') AP Senice @ Input Data D% 5 ouput Data 0 x
i «
1 i =< > UserlnfoRequest
| ) % xmins hitp:fflocalhostRequestl
& @ component <> UgerD sgpade

B 3270 Logon

| E) 3270 Terminal
<

[ Hame || Moditiec |
| TestViewllsetinfo Sun Oct 26
“iewllzerinfo Tue Mov 0«

SEEER® I

[ERTestviewUserinfo

@ WS Interchange: Viewlserinfo via Senvice WiewUserinfoService at Endpoint Location: "hitp:/Mocalhost RequestUserlr

& Project ﬂ
Wied Moy 05 06:10:42 C5T 2003
| @t output [l Waten [ +# Tada [ < Fina
Feady
Click the Execute All icon € on the toolbar.
Click OK on the Execution Completed dialog. You should see results returned by the SOAP
service in the Output DOM of the editor.
[ QQ Test\-"ieNUserInfo]
H Input Data O x 3 output Data O x
] [E-<>UserinfoResponse
hitp:iflocalhostRequesty 4 ¥mins hitpaiflocalhostRequestUserinfolresaol
<> UserlD SSpade <> UserlD SSpade
<> |astMame Spade
<> Firsthame Sam
<> |nitial
<>yorkPhone f55-667-75598
<> Title Security Manager
<> Department
SEEE2OIN
[ERTestviewUserinfo
@ WS Interchange: ViewUserInfo via Service ViewUserinfoSenvice at Endpoint Location: "hitp:ilocalhost RequestUserlr
<]
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When you look at the server console, you will see the log results from the exteNd Composer
runtime:

., Application Server

</batchResponse’

++++++ Fpri Jan B @7:28:35 CST 28684 USER LOG FROM RegquestlUserInfo
Debug xit from RequestlUserInfo LDAP Component,. output is:

<?xml version .B" encodin UTF-8"%>
{UserInfoResponse xmlns="http:-/slocalhost/RequestUserIinfo-resources schemas User|
InfoResponse .xsd">

{UserID>SSpadelUserID>

{LastMame >Spade<{-LastName >

{FirstMName >Sam{ FirstMName >

<Initial><{/Initial’

{WorkPhone >555-667-7?598<{WorkPhone >

{Title>Chief of Pediatric Surgery{sTitle>

{Department >{/Department >
</UserInfoResponse’>

++++++ Fri Jan B9 @7:28:35 CS5T 2884 USER LOG FROM VieuwllserInfo
Debug ervice: Response returned:
<?xml version .8" encoding="UTF-8"7>
{UserInfoResponse xmlns="http:-/slocalhost/RequestUserIinfo-resources schemas User|
InfoResponse .xsd">
{UserID>SSpadelUserID>
{LastMame >Spade<LastMame >

Congratulations. You have successfully completed an exteNd Composer service and deployed it
with a SOAP service trigger.

6 Close the exteNd Composer Designer application by using File>Exit. You will not need exteNd
Composer for the remainder of this Guided Tour.

7 When prompted to confirm closing exteNd Composer, click Yes.

Next lesson Inthe nextlesson you will complete an exteNd Director portal application that allows end
users to consume the service.
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Completing the exteNd Director Project

About this lesson

What is exteNd Director?

exteNd Director is an interaction portal server that enables IT organizations to rapidly deliver and easily
maintain rich, personalized Web applications. exteNd Director provides a comprehensive development
environment to help you create state-of-the-art interactive applications that users access through a portal:

*

Objective

Powerful J2EE capabilities for the rapid implementation of sophisticated, services-oriented
business Web sites

Dynamic content, data, and Web Services

Build interactive form-based applications that consume Web Services

Model business processes using workflow, rules, and content management

User personalization and profiling

Deliver to any front end (browser, PDA, phone, kiosk)

Multiplatform, multivendor combinations of application servers, databases, and operating systems

In this lesson you will build a simple application that will present an initial form to the user requesting a
user ID and then will invoke the Web Service (Composer ViewUserInfo) you deployed. The application
will then display the results returned using one of two forms depending on whether user data or a message
was returned. This application will run as a portlet in a personal page of a portal application. As you
complete the application you will also have the opportunity to test your application.

What you will do

N O h ON-

Create a Web Service pageflow using a wizard

Sidebar: the resource set in an exteNd Director application
Test the default pageflow you created

Edit additional XForms

Add a new form to the pageflow

Change links to include the new form in the pageflow

Test the revised pageflow
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EXERCISE 4-1: Create a Web Service pageflow using a wizard

In this exercise you will use an exteNd Director wizard to create a pageflow—an exteNd Director artifact
that links together XForms (presentation and data binding) to the invocation of a Web Service. The
wizard builds XForms based on the schema in the Web Service and ties it all together to invoke the Web
Service—and includes default exception handling. All this without you writing any code.

1 Click the New File icon L2 .

2 In the New file dialog, select the Portlet tab.

3 Select the Web Service Pageflow Wizard.
Brenrie x|
.j Choose a file type.

Creates a Pageflow populsted by Forms and Activities to access a'WebhService.

General Pol'tall' Portlet || Rules || Web Services || Workflow || XML

Composer Pageflow

&

Create a new Composer Pageflow
Database Pageflow

Create a new Database Pageflow

Java Activity for Pageflow
Create a new Java Activity for Pageflow

CSS file
Create a new CS5 file

—
=
L=
@

Form
Create a new Form
Pageflow

Create a new Pageflow process definttion

Portlet
Create a new Portal Portlet.

Portlet using a Web Service

Create a Portlet from an Existing Web Service.

g Web Service Pageflow
Create a new Web Service Pageflow
I
]

4 Click OK. The Web Service Pageflow Wizard displays.
5 Type UserInformation for the Base Name.

6 You must select the WSDL document for which you are building a user interface. There are two
ways you can do this:

+ The Browse button allows you to select a WSDL that is not currently part of your project.

+ The Resource Set button lets you select a WSDL that is stored in your project, for example, the
WSDL for the exteNd Composer service you will be using.

Use the Resource Set button to navigate to the location of the WSDL in the exteNd Composer
project. In the Choose file dialog expand the folders until you see the ViewUserInfo.wsdl file.
Select the ViewUserInfo.wsdl file. Click OK.
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Accept the default checks on Use CSS Layout and Use the default WSRP CSS classes:
Specify the details of this Web Service Pageflow
Base name: '_lserlnformation

WSDL file: |nf0Project\c:0mposer\wsdl\ViewUserlnfo.Wsdl [ Browse. .. ” Resource Set..

x|

Mote: Only document-style WSDL files that contain a schema can be used in this wizard,
Use €55 Layout

Use the default WSRP C55 classes

o (v

8 Click Next.

| cancel |

9 The WSDL has only one operation, so take the defaults for the Select the Web Service Method
dialog by clicking Next:
x
Choose a web service and an operation for this WSDL file.
“fou have chosen the WSDL file D:\GuidedTour\template'\RequestUserInfoProject\serinfoPr. ..
Choose a web service from this WSDL file: IViewUserInfoService |Z|
Choose a port for this web service: IViewUserInfoPort |Z|
Choose an operation for this web service: IViewUserInfoOperaﬁon |Z|

10 On the Formatting Controls tab, select 2 for number of columns.
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11 Select above for the label alignment.

x|

Specify the formatting for the controls on this form

Specify the number of columns for this page: |2
Specify how to align the labels relative to the controls: Iabove
Specify the width for each column: |150 Ipixels
Specify the font size that will be used in the browser: |12 Ipoints
Specify the gap between rows: r

Specify the vertical gap between the label and its control: r

I = Back ” Finish ” Cancel ]

12 Click Finish.
13 Click OK on the Done creating forms and pageflow message:

[@ UserlInformationFlow, xml EI]

Y o B Yfsaa ] X aT®
[ Genel'alJLActi\ritiesJL DatabaseJ Links
Exception Handler  Exception Handling page
! <htm|=
~ =
CheckPoint [ -
—_—— * R We
Input Form Subrit Request |, -9 i
Yiew Mode b, —— — E_g T
m“
JRACN _MewRequest -7 [V
| ]
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14 Use the percentage dropdown list psezw to adjust the size of the pageflow diagram in the editor.
100% is a good compromise between size and readability.

|' @ UserlInformationFlow, xml |Zl]

oo E G MR TH

|\ GeneralJLActi\rities |L Database | Linlks |

La

Exception HandleException Handling page Help

fy——TF

CheckPoint
E*\' _ -\.I'u'eb seniice 1
Input Form  Submh Reques, 47 ‘E:"} N
- il

Wiew hode — —=
E

—

;% Output Form

EXERCISE 4-2: Sidebar: the resource set in an exteNd Director application

An exteNd Director resource set organizes descriptors and other files used by exteNd Director
subsystems and provides for dynamic loading during development, avoiding frequent redeployments and
speeding up your testing. Each custom Web application can include a resource set.

A resource set holds application-defined resources and classes. Some of these resources are templates or
definitions for using a subsystem’s features—such as a rule, XForms, pageflows, or a portlet descriptor.
Others specify how subsystems work together—such as bindings between rules and users. Resources are
usually XML files; some are accompanied by Java classes.

A resource set organizes your application’s resources in a known directory structure and within exteNd

Director you may use the Resources tab in the Navigation Pane to find the various artifacts in your

project. For example, if you wanted to find all the files created in the previous exercise you would do the

following:

1  Select the Resources tab in the Navigation Pane.

|' ﬁ View : Config/Services by Subsystem ]
[ :-% Search n

config.services by subsystem.war xml

RequestUserinfo-Resourceset
% Wiew Descriptor.xml (RO)
=} [ Config/Services by Subsystem
[+ 3 contentMgmt Service
[+ 3 Directory Service
[+ 3 Framework Service
-3 pPac
-3 puc
-3 Portal
[+ 3 Portal service
[+ RsS Service
[+ 3 Rule Service

[+ 3 search service

@ Project
Resources

C;?;;g Relationship Viewer

1€

?218 Directory JL

ﬂi_, Registries |

2 Select the Search tab.
3 In the File Name text box, type UserInfo.
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4 Click the Search button:

[ Wiew : Mo Views |
[ %, Search ?:8 Relationship Viewer |

Resource Set: |RequestUserInfo-ResourceSet E‘

File Mame: |Userlnf0

Directory: |

==

Data: |

F RequestUserinfo-ResourceSet
= com
= document-template j
= form
B8 pageflow-process
B8 portal-portlet
3 wsdl

HEEHBED E|L

| Found 21 matching elements.

?:8 Directory JL @ Project

(R) Registries | Resources

5 You can save this search as a view to reuse the search criteria at a later time. Click the Save button.
6 Name the file UserInfoStuff.xml and click Save.

The view is an XML file that describes the search criteria and display structure, and you may edit it
to server your specific needs.

7 Close the open editor by clicking on the editor title tab to close the UserInfoStuff.xml file.
Select the View tab.
9 In the dropdown list find UserInfoStuff, then select it:

[ @ Wiew : Userinfo
= =) ; o
{ -4, Search T[ ;jjjg Relationship Viewer

[Er=

UserinfoStuff xaml

Regquestlserinfo-ResourceSet
View Descriptor sxml
= Userinfo
= Userinfo
-3 com
=8 document-template
= form
Userlnformationinput . xhtml
UserlnformationOutput xHtm)
UserinformationResponse_[
UserlnformationResponse_N
-3 my-views
-3 pageflow-process
-3 portal-portlet

<] |
?:8 Directory JL @ Project

(R) Registries | Resources

You may expand the folders to see the various artifacts you created—and by double-clicking a
particular entry the appropriate editor for working with that artifact will be opened.

=@

La

T

L For details, see the chapter on using the resource set in an exteNd Director application in
Developing exteNd Director Applications.
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EXERCISE 4-3: Test the default pageflow you created

Because pageflows and XForms created by the Web Service Pageflow Wizard are stored in the resource
set and you already deployed the application, you may immediately test the default portlet that was
created. This is because by default during development, your exteNd Director project was configured to
dynamically load the resource set artifacts.

1 Open a browser window.
2 Type the URL http://localhost/RequestUserInfo/portal/portlet/LoginPortlet in the address bar.
3 At the portal login page, click the New User? link:

Novell:
exteNd”

Uzername: Pazsword:

=+ Mewy Uzer?

N Login

4 Enter the information to create a new user—for example:
+ User ID: userl
+ Password: password
+ Confirm Password: password
+ First Name: Test
«+ Last Name: User
+ Email: userl@somewhere.com
5 Click Register.
Click Continue to return to the login page.

(-]

7 Log in using the account you just created. Click Login or press Enter.

You will see the default portal shared page with some sample portlets. You will create a personal
page where the portlet for the pageflow you created will be placed. You will use this page later in
this lesson to test and review your changes.
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My Portal - Microsoft Internet E}q)lnrer

File Edit ‘Yiew Favorites Tools Help

s=Back * = - @ &) | @Saarch (3] Favorites @Media 8 | %v =

Address I@ http: }flocalhost/RequestUserInfofportalfon/Def aulk ContainerPageCorpor ate %= 20Home

ne Test User

N Mowell® exteMd™ Director

Mowvell | Mews | Portal Home

Monday, June

Personalize | Logout

Shared Pages
- Corporate Home
- exteNd Welcome

N Stock Quote

Waltham, MA Stock Symbol: I
Get Cluote I
Last updated on Qct 17, 3:56 pm EDT
pdy Feels Like i SBIeF

E it =4 4_;-' High af {552k
avorites ; 2yt Hurnidity 145 %
{ EnteNd Products Fair windspeed ¢ W B MPH

exteMd Solutions : Barometer (o i

: 55°F g

¢ Director CMS Cewpoint 34°F

§ Movell

J2EE Community

Mote: This is sarmple, non-live data. To begin seeing live Weather
data, enter the information requested below and click Display.

Enter Zip Cod Cit -
5?;‘; 'p Code or Lity, I— Disnlay |

Movell Developer Kit

- Get developer software and tools,

Movell exteMd Product Information

- Learn rmore about tools for advanced web application development.,

. =l
[ R rocalintranet

|@ Done

8 Click the Personalize link:

Novella

exteNd"

PORTAL PERSONALIZER Director

Personal Pages

rou can create multiple personalized pages which can be customized to a specific need, Each page can contain different content
and will allow you to easily switch between certain tasks,

Personal Pages:

Page Name:

Description: ;I

Update

HNew E] Remove

Choose Content Arrange Content Choose Layout Fortal
Default Page:

rou may change your default Page by selecting a different Personal page or Shared page from the list below,

Default Page: |N0ne | Set as current

Container Page

A Container Page is a portal page created by an administrator which contains pre-selected content, Each user will see this

content when visiting their individual portal pages. vou may change which default Container Page yvou see when visiting your
pages by selecting a different Container Page from the list below,

9 Click New under the Personal Pages list to create a new personal page.
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10 Change the name of the page to User Info Test, then click Update:

Personal Pages

rou can create multiple personalized pages which can be customized to a specific need, Each page can contain different content
and will allow you to easily switch between certain tasks,

Personal Pages: Page Mame: |User Info Test

Description: [Frier Description Here ;I
[
Update
Choose Content Arrange Content Choose Layout

11 In the Default Page text box, select the page you just created.
12 Click the Set as current link. This allows you to quickly get to this page in the portal page.

Default Page:

rou may change your default Page by selecting a different Personal page or Shared page from the list below,

Default Page: |User Info Test | Set as current

13 Click the Choose Content link.

14 Scroll the Available Portlets list until you find UserInformationPageflow, then select it and click
Add.

PortalPortletSelector - Microsoft Internet Explorer — |E||i|

CONTENT SELECTOR exteNd | Al

Select content for this Portal Page (User Info Test)

Filter:
|AII Categories ;I Selected Content:

UserInformationPage

Available Content:

Rss Mews Feed :I

Sample Message

Shartcut

S0OL Query }
Stock Applet . .
Stock Portfolio Add
Stock Quote

Survey

Things to do... Q
Topics
UserInformationPageflow
Weather Service

Wb Mail

velcome Message

Remove

I

Content Preferences

Name: UserlnformationPagefiow Name: |JserlnformationPag Update

Description: Description:
UserInformationPageflow UserlnformationPageflow

Mo Preview Image

Mo Preview Image Available
Available

Save Contents Cancel _I
=

15 Click Save Contents.
16 Click the Portal link.

17 Atthe top of the page, click Portal Home—or under Personal Pages click User Info Test (the page
you just created)—to view your pageflow portlet.
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. fl
18 If you see the message Portlet did not respond in time, click the . link or reload the page (by
clicking on Portal Home or under Personal Pages clicking User Info Test).

& My Portal - Microsoft Internet Explorer i i ] 4]

File Edit Wew Favorites Tools  Help |

dgack - = - D 7at | @ search  GelFavorites  GMedia (% | - S

Address I@ http:fjlocalhost/RequestUserInfojportalfcn/Def aultContainerPagefup_User%:20Info%:20Test

zorne Test User

N Mowell® exteMd™ Director

Movell | Mews | Portal Home

Tuesday, June

Personalize | Logout

Shared Pages
- Corporate Home
- exteNd Welcome

UserInformationInput
UserID

- User Info Test Isamplei

Personal Pages

Favorites
exteMd Products
exteNd Solutions
Director CMS
HNovell

Submit Reguest

J2EE Community

=l
- T

|@ Dione

19 Type SSpade in the UserID text box of the UserInformationInput Portlet page, then click the
Submit Request button.

me Test User

N Mowvell® exteMd™ Director

Mowvell | Mews | Portal Home

Mew Request |

Shared Pages L Informatio

- Corporate Home .

- xteld Welcame UserInformationOutput
UserID Lasthame

Personal Pages

- User Info Test SSpade Spacle
FirstName Initial

: Favorites Sam

i exteNd Products .

exteMd Solutions WorkPhone Title

= 555-667-7598  Chief of

P Movell [ I S

 12EE Community Departrment

20 Click the New Request button to return to the first form.
21 Type SP in the UserID text box, then click the Submit Request button.
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You will not see any message.

22 Click the New Request button to return to the first form.

If you take a peek at the exteNd Application Server console, you will see the Log output from the
exteNd Composer service that shows the data returned to the application.

r;NAppIic ion Server

{resultCode code="B" descr="Success"/>
{ssearchResultDone >
{/searchResponse’>
<sbatchResponse’

=101 x|

++++++ Fri Jan B9 @9:88:81 CST 28@4 USER LOG FROM RequestlUserInfo
H i UserInfo LDAP Component. output is:
TF-8"2>

InfoResponse.
{Mezsage >Requ ed userID: SP not found.<{sMessage>
</UserInfoResponse’

++++++ Fri Jan B9 @9:88:81 CS5T 2884 USER LOG FROM VieuwllserInfo
Deb Service: Respo returned:
*1.8" encoding TF-8"2>
'http:/~localhost RequestUserInfosresources/schemas/User

ed userID: SP not found.<{sMessage>
>

The forms and pageflow created by the wizard did not take this form into consideration, so you
need to change the pageflow. You will add a conditional decision to the pageflow that will decide
which form is displayed; the decision will be based on the data returned from the invoked Web
Service. This is your task for the rest of this lesson.

EXERCISE 4-4: Edit additional XForms

A form was already created that displays the message returned by the Web Service when an invalid
request is made. You will review this form and make some slight modifications. In the next exercise you
will insert this form into the pageflow you created earlier with the Web Service Pageflow Wizard.

N =

h W

4=, Resources

In exteNd Director, select the Resources tab - J of the Navigation Pane.

Select the View tab in the Resources Navigation Pane view, then use the dropdown list to select
UserInfoStuff (the view you created earlier).
Expand the listed folders by clicking the @ icon until you find the form folder.

Double-click UserInformationResponse_Message.xhtml, which will open the form in the
XForms Editor.

|' (P} view : Userinfo # |§ UserinformationPageflow.xml (] | &, UserlnformationResponse_Message xdhtml xJ]
i T - -
-4, Search -2 Relationship Viewer r=o | | Instance Data:
[ 4 [ ° hoEadfh-on=8 EEE 5!
| %Forms || Align/Distribute | A ,{F'ath:l
I\Jserlnfn‘}tuff saml [v] M |
— — Vigssage
- T - i [ Document ~|
[ Userino [~] 2
- 'EI’ B e 5 I— =} €3 wforms:model l
(] composer = = 5
G .J_‘ document-template 3 e @ id madel _warp_rewrite_ [v]
=H= f\J’I m g i | | |Z|
Userinformationinput, xhtr j —
52 UserinformationOutput.xh)
2 |serinformationResponse:
T LserinformationResponse
[F-130 my-views
[+ pageflow-process
[+ portal-portlet
[+ wsdl |~ Eﬂ
[ s 1 | 3 NS— B
[ Event Hantllersl ~
| ?:8 Directory ” @ Project ‘—l
k. N 35, [ 3 e :
|\ I'IR, Registries l @ Resources | ?EFU' m J| s Mcde\“!_t]j SULIICE'”‘ sl WForms PlewewJ

=

You are going to change the look and feel of this form by replacing the input message text box with
an output (display only) text box.
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5 Select the Layout Region and, holding the left mouse button, increase its size by scrolling
downward with the mouse.

N -

Message |

[P

6 Click the Submit button on the form and press the Delete key to delete it.

7 Click the Insert XForms output # button.
8 Click below the Message text box to add the Output control.

B i Ir
hOESdiot=dEengEE "
|\ “Forms || Align/Distribute | £

Message = r

!
|+

[rEvent Hancllersl [»] 2 [
1 & e ITEAT - | - o |

NOEAdom = e E 5 EE
|\ “Forms || Align/Distribute |

Message =

: |

| |} m
New output ﬂ'Outpu.t valu..:

9 Select the Input message text box, then press the Delete key.
10 Select the Output text box and drag it below the New output label.

11 Select the label and text box while holding the Ctrl key, then drag both toward the top of the layout
area.

12 Use the Align/Distribute tab to properly align the controls on the layout.

F ¥ Wb sSHHI
XFaorms | Align/Distribute
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[ @ UserInformationFlow. xml (3] ] ﬁé‘! UserinformationResponse_Message. xhtmf [x]

F ¥ W hsSMHI
XFaorms || Align/Distribute

L] LI
Hlew output
[ | n

II |}
: ﬂ Outpu.t valu..

<] I

[rEvent Hancllersl [»] 2 [

| fg Form l':. Model |l@ Source |L‘:§ #Forms Preview |

13 Click the Save icon B to save your changes

14 Enlarge the Output text box by clicking it and then dragging the corner down and to the right.

15 In the Instance Data Pane click the ® icon until you see the Message element (you may need to

scroll).

16 Click the Message element, the hold the left mouse button and drag the element on the Output text

box in the Form Pane.

[E UserInformationPageflow. xml 3] ] % UserinformationResponse_Message. xhtmf [x] ]

F e mebsSmHI
XForms | Align/Distribute

Instance Data:

=t 4 HPath: IIﬂata:Hessage

Results: elementidata:Message)

|\ fg Form L':. ModeIJLE SoLu'ceJt‘g@ #Forms Pl'e\riewJ

[ n [ ~
EJGW OLdtpUt : # "default” I"rl'tp:.l’.l'loc:alhos‘t.l'REqUES‘t
] ] ] = (;>,| Message =
[T test
2 <] |
ki : n =
Wdata: Message] =)
[} = o Left: E Top: I:--
Width: I il Height: I 15
[T ]
[» Event Hancllersl X D

17 Click the Save icon H to save your changes.
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18 Select the Output (label) tab in the Property Inspector, scroll to the top, and change the Label to

read Message:.

[E UserInformationPageflow. xml 3] ] % UserinformationResponse_Message. xhtml [x] ]

FF e Wb sSWHHI
XForms | Align/Distribute

| | | | . | |
Ev‘lessage. 0

| [data:Message]

Instance Data:
=+ <4 ¥Path: |Hata:Message

Results: elementidata:...

# "default” r'rrtp:.l’.l'loc:

= ¢3| Message
p— |

<] |

[» Event Handlers f... Ixforms-in\rah'cl at bady icl='c|1'\r_ws|'p_... X @

| fg Form L':. Model |LE Source |L‘:§ XForms Preview |

19 Click the Save icon B to save your changes.

20 Click the divider between the Form Layout section and the Instance Property section of the XForms
Editor to expand the Form Layout, showing you all the items in the tools tab in the Form Layout

section.

TIP: If this does not work, maximize the Director Designer, then hold the left mouse button and drag

[T test [v]

<1
|' Outputilabel) || Output || Hints |

Label:

[ee——s L

r

] Hidden

I0:

I

the divider to the right until you see all the XForms tools on the tab.

roEEd-or=0 iR oEERE

|\ *Forms || Align/Distribute

21 Click the Insert Pageflow link region L button.
22 Click in the Form Layout to add the control to the form:

<] | B

This region will be used by the Pageflow button link when you add this page to the existing

pageflow.

[E UserInformationPageflow. xml 3] ] % UserinformationResponse_Message. xhtmf [x] ]

roEEdg-om=0 EERnEEEE

|\ *Forms || Align/Distribute

| | | | . | |
Ev‘lessage. 0

| [data:Message]

Instance Data:

=t 4 HPath: Idata:Hessage

Results: elementidata:...

# "default” r'rrtp:.l’.l'loc:

= ¢3| Message
p— |

:
: |

[» Event Handlers f... Ixforms-in\rah'cl at bady icl='c|1'\r_ws|'p_... X @

| fg Form L':. Model |LE Source |L‘:§ XForms Preview |

23 Click the Save icon B to save your changes.
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EXERCISE 4-5: Add a new form to the pageflow

In this exercise you are going to add the Message Display page to the existing pageflow and then change

the links on this page to include this page as part of the application flow. One of the links will have a

condition that will check what result was received from the Web Service to determine which page should

be displayed—the User Information page or the Message page. Your objective is to go from the flow

pictured just below to the one pictured under it.

Original pageflow

Exception HandleException Handling page Help
<htm|> <html>
T

Ehectkfoint ] .*\' i \*\J’u’eb service 1

Input Form  Subml Reqm ,v

- | " Y —
Wiew Mode — —= -9 Output Farm
MR o o
T M Boguesl. 5y
Target pageflow
Exception HandleException Handling page ’,—"’Help - .
I L=
£ L 12 v
’,-'/ / hessage
-~ ’CheckPolnt - / Link 5
e E*\ — — \.I'll'eb service 1
InpubForm Sunmlneqm > -E:‘-}
Bttt Link 3 - LT 1%.,
Wiew Mod oy —— — User Inf
iew Mode 5 LQ'%"-\-“E e Lw% zer Info
te-l Haw Raquasl ="

1  Select the UserInformationPageflow.xml file in the exteNd Director Edit Pane.
UserInformationPageflow.xml opens in the Pageflow Modeler.

| B UserInformationPageflow.xmi [ ][% UserinformationResponse_wMessage.xhtml (%) ]

N o B Ghox @R 4O T B
| General || Activities || Database || Links

[>]

Exception HandleException Handling page Help
<html> <htm (>
by —— -5 e

CheckPoint =
e %— — = '\.I'u'eb service 1
T

Input Farm  Submk “Gqﬂ -

F =
Wiew hode — -9 - Output Form
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2 Sclect the Activities tab in the Pageflow Modeler.

L GeneraIJ[ Acti\ritiesJL DatabaseJ Links

3 Click the Form activity ® toolbar button.

4 Add the form to the right of the Help HTML activity in the pageflow diagram by moving the mouse
pointer to the location and clicking the left mouse button:

Help

0
)
— = '}@’Feb service 1

5 Click the label added under the Form activity you just placed on the diagram and edit it to read
Message.

6 Double-click the Form activity you just placed on the diagram to open the Property Inspector for
the activity:

ﬂ ies x|

[ m[ Instance Data][ Copy Scoped XPaths][ Design UI]
Mame "Drm activity 3 |_
Description |

You may drag this window to a more convenient location on you desktop so that it does not cover
the diagram or other parts of the editor that you need to view.

7 Type Message in the Name text box.
8 Click the Form tab.

Click the & button next to the XHTML text box on the Form tab.

10 In the Choose The Scoped XPath dialog, select ResourceSet from the dropdown list and then click
the Browse button.
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11 In the XPath Navigator, use the ® button to open the ResourceSet and form lists and then select the
UserInformationResponse_Message.xhtml file:

B Scoped Path Navigator x|

Enter an XPath expression and press Evaluate to see the results

XPath: | /ResourceSet/forn/UserInfornationResponse_Message.xhtml Evaluate
=

Real-time

[ Decument
[Z 4¢3 ResourceSet
= ¢ form
¢» Userinformationinput.xhtml
¢» UserinformationOutput, xhtml

€¢» UserInformationResponse_Data,xhtml

E-EH-E-&

€&| UserlnformationResponse_Message, xhtml

12 Click OK.

13 Click the Save icon B to save your changes.
14 Click the Instance Data tab.

zl
Activity || Form | Instance Data | Copy Scoped Paths || Design Ul |
Inbound Documents

Outbound Document Mame I E]

15 Click the & button next to Inbound Documents.

ﬂ Inbound Documents x|
Primary Data: I @

16 Click the E button next to the Primary Data text box.

ﬂ Choose The Scope x|
Scoped Paths: hesourceSe{l [~]

[ Show XML File Content
|

17 Click the Scoped XPaths dropdown list to select /Flow/document/RESPONSE.
18 Click OK.

19 Click the Save icon & to save your changes.

EXERCISE 4-6: Change links to include the new form in the pageflow

Now you will create links for the new form to include it as part of the normal flow of the application. The
Web Service will go to both forms with a condition added to one of the links to determine which one. The
new Message form will link to the Input form completing the loop in the application.
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1 Select the Links toolbar in the Pageflow Modeler:

223

L GeneralJLActi\ritiesJL DatabaseJ[ Links

2 (Click the Button Link button = .

3 Click the Message Form activity, drag to the Input Form activity, then left-click to create a link
between the two activities:

4 Click the link you just added to select it.
5 In the Property Inspector in the Button Link tab, change the Description to New Request.
This is the value that will appear on the button when the page is rendered in the browser.

6 Click the Link button =

7 Click the Web Service activity, drag to the Message Form activity, then left-click to create a link
between the two activities:

i
-

=

8 Change the label next to the Output Form to read User Info.

9 Click the Save icon B to save your changes.
10 Click on the link between the Web Service activity and the Message Form activity.

11 In the Property Inspector, click on the Edit Expression link “"=£*="= ip the Link tab.

12 In the Scoped Path text box of the Expression dialog, type the following expression (be careful with
the punctuation and case):

/Flow/document/RESPONSE/* [local-name () ='UserInfoResponse']/*[local-
name () ='Message']
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13 In the operator dropdown list, select is null, check the Not check box, then click the Add button:

x

Scoped Path: l-name()='UserInf0Response'].l'*[local-name()='Message'] E]

[#] Mot Ior [~] Iisnull [~] Istring [~]
WValue: | E]

Flow/idocument/RESPONSEMlocal-name()="UserinfoResponse'|*[local-name)="Message'] (r

<] ]

14 Click OK.

15 In the Link tab of the Property Inspector, make sure that the Precedence text box has a value of 1.
16 Click on the link between the Web Service activity and the User Info Form activity.

17 In the Link tab of the Property Inspector, make sure that the Precedence text box has a value of 2.

18 Click the Save icon B to save your changes.

EXERCISE 4-7: Test the revised pageflow

Now that you have completed the changes to the pageflow to incorporate the new page, the last step is to
test your changes in the application server. Because of the dynamic loading feature of exteNd Director,
your changed forms and pageflow have been automatically loaded into the application server—and all
that is needed to test the changes is to open a browser window and log in to the Portal application.

1  Open a browser window.

2 Type http://localhost/RequestUserInfo/portal/portlet/LoginPortlet in the address bar, then press
Enter.

3 Loginas:
+ User: userl
+ Password: password
4 Under the Personal Pages list, click the User Info Test link.
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5 In the UserID text box of the UserInformationInput page, type SSpade and then click Submit
Request button.

N UserInformationFlow

UserInformationOutput

UserID Lasthame
SSpade Spade
FirstName Initial
Sam

WorkPhone Title

555-667-7598 Security Manager

Department

Mew Request I

6 Click the New Request button.
7 Type sp in UserID text box, then click the Submit Request button.

N UserInformationFlow

Message:

Requested
userlD: sp not
found,

Mew Request |

8 Click the New Request button.

N UserInformationFlow

UserInformationInput
UserlD

Subrmit Requestl

9 Close exteNd Director by using File>Exit.

Congratulations. You have successfully completed the Guided Tour.
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Summary
In this Guided Tour through the development features of the exteNd 5 Suite, you have:

+ Used exteNd Composer to create a service that extracts information from an LDAP directory.

This showed you how you can use exteNd Composer to XML-enable your legacy systems and use
the information in them to provide new services.

+ Deployed the service as a SOAP service.
This made it possible to take a standards-based approach to accessing this information.

+ Used exteNd Director to build a browser-based interface that can use this service by accepting
input from the user and then displaying information to the user.

In short, you have gone from producing a Web Service to consuming a Web Service, all with one
integrated set of tools. The entire application was provided by a robust J2EE application server. And all
this without writing one line of Java code.

If you were to continue development of your Web Service application, the next step would be to go from
a query-only application to a maintenance-and-query application. But that is a challenge for another time.

Learning more To learn more about Novell exteNd, see the Learning Resources page in Welcome to
Novell exteNd in this help system.
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